
✁
✁

COMPUTER STUDIES

���������	
���


Question Papers

Formative Assessment : I

Formative Assessment : II

Formative Assessment : III

Formative Assessment : IV

Summative Assessment : I

Summative Assessment : II

Summative Assessment : III

Total Pages : 24

�	���������� �	��	�������
������

�	����������������	
�����������������
��������������	����	����������

�����������	��

����������������������
��
��������� �
�� ���

����������	���
������ !"��	����#
���	��

�������������������
���������
�	���$��
%���������
���	
���������	����������
��$

����
��
	���	�����!%�����

������

CLASS - 2

C-19

B



Vikram Computer Studies

Months Chapters

FA – I June – July Chapters : 1, 2

FA – II August Chapter : 3

SA – I September Chapters : 1 – 4

FA – III October – November Chapter : 5

SA – II December Chapters : 1 – 6

FA – IV January – February Chapter : 7

March Revision

SA – III April Chapters : 1 – 8

CLASS : 2

LESSON PLAN



3

Name : Section : Roll No.

25

FORMATIVE ASSESSMENT - I
Class - 2 :: Vikram Computer Studies

Time : 1 Hour Max.Marks: 25

C - 19

Syllabus :
Text Book : (1 and 2 Lessons)
Page Nos : 5 - 17

I. Fill in the blanks with the help of words given in the box. [5 × 1 = 5 M]

E - mails, Electronic, Medical, Books, Power

1) A computer is an ...................... machine.

2) It is used in library to keep records of ................

3) It is used to prepare ..................... reports.

4) Computer is used to send ....................

5) UPS stands for uninterrupted ................. supply.

II. Write 'T' for true and 'F' for false. [5 × 1 = 5 M]

1) A Pen drive is also known as Flash drive.

2) The printed copy on a paper is called soft copy.

3) A computer cannot give correct results.

4) Dot matrix is a type of printer.

5) Computer can store large amount of information.

III. Match the following. [5 × 1 = 5M]

1) To print bills a) Hospitals

2) To maintain records of patients b) School

3) Making time table c) Shops

4) To book tickets d) Bank

5) To know details of our accounts e) Railways

1 Computer Studies ★ FA - IVikram Text Book - 2

✁
✁

Text Book - 2
Vikram
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2 Computer Studies ★ FA - IVikram Text Book - 2

IV. Answer the following questions : [5 × 2 = 10 M]

1) What are the uses of computer in a bank ?

2) What are the main parts of a computer ?

3) What is a keyboard ?

4) Write any three features of a computer.

5) What are the different types of printers ?

❖ ❖ ❖ ❖ ❖
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Name : Section : Roll No.

25

FORMATIVE ASSESSMENT - II
Class - 2 :: Vikram Computer Studies

Time : 1 Hour Max.Marks: 25

C - 19

Syllabus :
Text Book : (Lesson-3)
Page Nos : 18 - 24

I. Fill in the blanks with the help of words given in the box. [5 × 1 = 5M]

Device, Data, Fast, Output, Input

1) Calculator is also an electronic ..........................

2) Computer works on ....................... speed.

3) Input entered to computer is called as ....................

4) Computer works on the principle of ...................., Processing and Output cycle.

5) We input data in computer, it processes them and gives .................

II. Write 'T' for true and 'F' for false. [5 × 1 = 5M]

1) When a computer works on data, it is called processing.

2) Computer and Calculator both are electronic devices.

3) Computer has very short memory.

4) Computer is an electronic machine.

5) Data entered into computer is called output.

III. Tick ( ✓✓✓✓✓ ) the correct option. [4 × ½ = 2M]

1) Which part of a human body works like a CPU .......................

a) Ears b) Mouth

c) Hand d) Brain

2) We can see more results on .................... at the same time.

a) Computer b) Calculator

c) Mouse d) Keyboard

✁
✁

Text Book - 2
Vikram

1 Computer Studies ★ FA - IIVikram Text Book - 2
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2 Computer Studies ★ FA - IIVikram Text Book - 2

3) Data and instructions together known as

a) Processing b) Input

c) Output d) all of these

4) Which part of a computer does all the calculations ?

a) Speaker b) Mouse

c) Printer d) CPU

IV. Match the following : (incase of finding sum of 4 and 5) [3 × 1 = 3 M]

1) 2, 7 a) Output

2) 9 b) Instruction

3) Add c) Input

V. Answer the following : [5 × 2 = 10 M]

1) Which part of a computer displays the output ?

2) Which device is used to enter data into a computer ?

3) Mention the three steps on which a computer works.

4) Which device is used to enter data into a computer ?

5) Write any two main differences between computer and calculator.

❖ ❖ ❖ ❖ ❖
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Name : Section : Roll No.

25

FORMATIVE ASSESSMENT - III
Class - 2 :: Vikram Computer Studies

Time : 1 Hour Max.Marks: 25

C - 19

Syllabus :
Text Book : (Lesson-5)
Page Nos : 34 - 40

I. Fill in the blanks with the help of words given in the box. [5 × 1 = 5 M]

Number, Shift, Backspace, Delete, Spacebar, key

1) The .................... key erases character to the right side of the cursor.

2) The ........................ key is used to move the cursor right.

3) ........................ is the longest key on the keyboard.

4) There are two sets of ..................... keys.

5) The ....................... key is used in combination with some other key.

II. Write 'T' for true and 'F' for false. [5 × 1 = 5 M]

1) Down arrow key is used to move the cursor up.

2) ESC key is located on the lower right side of keyboard.

3) When the CapsLock light is ON, lower alphabet is typed.

4) By default, typed letters are displayed in capital.

5) There are only one enter key on the keyboard.

III. Match the following. [5 × 1 = 5M]

1) Space bar a)

2) Enter key b)

3) Backspace c)

4) Delete key d)

5) Arrow keys e)

1 Computer Studies ★ FA - IIIVikram Text Book - 2

✁
✁

Text Book - 2
Vikram
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IV. Answer the following questions. [5 × 2 = 10 M]

1) Name the various types of keys on the keyboard.

2) Which keys help us to move cursor on the screen ?

3) Name any four special keys.

4) Which two keys are used to erase the typed letters ?

5) What will appear on the screen, if you press                                    .

❖ ❖ ❖ ❖ ❖

2 Computer Studies ★ FA - IIIVikram Text Book - 2
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Name : Section : Roll No.

25

FORMATIVE ASSESSMENT - IV
Class - 2 :: Vikram Computer Studies

Time : 1 Hour Max.Marks: 25

C - 19

Syllabus :
Text Book : (Lesson-7)
Page Nos : 50 - 60

I. Fill in the blanks with the help of words given in the box. [5 × 1 = 5 M]

Ctrl + N, Ctrl + O,  Create,  MS Word,  File

1) If you want to exit Word, then click on Exit in the ....................... tab.

2) The shortcut key for opening an existing document is ....................

3) ...................... helps us to type text, correct mistakes etc.

4) The New option in the File tab helps us to ......................... a new document.

5) The shortcut key for opening a new document is ............................

II. State 'T' for true and 'F' for false. [5 × 1 = 5 M]

1) The Insert tab contains options like New, Open, Print, Save etc.

2) The Ribbon contains Tabs, Commands and Groups.

3) You have to open the File tab for saving the document.

4) Status bar is the bar that is located at the bottom of the Word window.

5) To close a file select the Insert tab from the menu options.

1 Computer Studies ★ FA - IVVikram Text Book - 2

✁
✁

Text Book - 2
Vikram
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2 Computer Studies ★ FA - IVVikram Text Book - 2

III. Tick (✓✓✓✓✓) the correct option. [5 × 1 = 5 M]

1) Which of the following tool bar on the title bar contains all frequently used options

of Microsoft word ?

a) Insert b) Quick Access Toolbar c) File

2) Which of the following contains Tabs, Groups and Command ?

a) Home b) Office c) Ribbon

3) Which of the following shortcut key is used to print a document ?

a) Ctrl + N b) Ctrl + O c) Ctrl + P

4) Which of the following tab is used to open a new file ?

a) Home b) Insert c) File

5) Which of the following button contains save option ?

a) File b) Home c) Insert

IV. Answer the following questions : [5 × 2 = 10 M]

1) What is the function of File tab ?

2) Explain the procedure of opening an existing file.

3) What are the steps of creating a new file ?

4) Write the steps of opening MS Word.

5) How will you quit from MS Word ?

❖ ❖ ❖ ❖ ❖
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Name : Section : Roll No.

50

SUMMATIVE ASSESSMENT - I
Class - 2 :: Vikram Computer Studies

Time : 2½ Hours Max.Marks: 50

C - 19

Syllabus :
Text Book : (1 to 4 Lessons)
Page Nos : 5 - 33

I. Fill in the blanks with the help of words given in the box. [10 × 1 = 10 M]

E-mails Mouse Electronic Medical Fast

Icon UPS Device Power Power

1) A ..................... has two or three buttons on it.

2) Calculator is also an electronic .........................

3) To start a computer, first switch on the ................... supply button.

4) A computer is an ...................... machine.

5) It is used to prepare ................... reports.

6) Computer is used to send ....................

7) Computer works on ...................... speed.

8) Small picture on the desktop are called .......................

9) When the electricity goes off, the .............. makes the computer run for some time.

10) UPS stands for uninterrupted ........................ supply.

II. State 'T' for true and 'F' for false. [10 × 1 = 10 M]

1) Icons are small pictures of program shown on the desktop.

2) Computer has very short memory.

3) Dot matrix is a type of printer.

4) Computers are used in offices for keeping records of books.

5) The first screen of the windows is called desktop.

1 Computer Studies ★ SA - IVikram Text Book - 2

✁
✁

Text Book - 2
Vikram
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2 Computer Studies ★ SA - IVikram Text Book - 2

6) Computer is an electronic machine.

7) A CD can store a little information.

8) Computer cannot give correct results.

9) The printed copy on a paper is called soft copy.

10) Data entered into computer is called output.

III. Match the following. [5 × 1 = 5 M]

1) To print bills a) Hospitals

2) To maintain records of patients b) School

3) Making time table c) Shops

4) To book tickets d) Bank

5) To know details of our accounts e) Railways

IV. Tick (✓✓✓✓✓) the correct option. [10 × 1 = 10 M]

1) A standard keyboard has ..................... keys.

a) 96 b) 100 c) 104

2) A ...................... helps in playing games and drawing pictures.

a) UPS b) CPU c) Mouse

3) Which of the following shows the files stored on the computer ?

a) Computer b) Recycle Bin c) CPU

4) A computer stores a large amount of ...........................

a) Money b) Information c) Water

5) ..................... makes a computer run when electricity goes off.

a) Windows b) UPS c) CPU

6) The thin bar at the bottom of the desktop is called ....................

a) Status bar b) Taskbar c) Title bar
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3 Computer Studies ★ SA - IVikram Text Book - 2

7) The printed copy on paper is called .......................

a) Soft copy b) Colour copy c) Hard copy

8) A ....................... works very fast.

a) Computer b) Man c) Animal

9) A ................... computer is kept on desk.

a) Laptop b) Palmtop c) Desktop

10) Which one of the following is not used to store data ?

a) Pen drive b) CD c) Mouse

V. Answer the following questions. [5 × 3 = 15 M]

1) Write the uses of a mouse.

2) What does the blue Title bar indicate ?

3) What is a desktop ?

4) Which device is used to enter data into a computer ?

5) Name the three types of computers.

❖ ❖ ❖ ❖ ❖

✁
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4 Computer Studies ★ SA - IVikram Text Book - 2
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Name : Section : Roll No.

50

SUMMATIVE ASSESSMENT - II
Class - 2 :: Vikram Computer Studies

Time : 2½ Hours Max.Marks: 50

C - 19

Syllabus :
Text Book : (1 to 6 Lessons)
Page Nos : 5 - 49

I. Fill in the blanks with the help of words given in the box. [10 × 1 = 10 M]

E-mails Mouse Medical Input Output

Icon Electronic Eraser Paint Spacebar

1) A ................... has two or three buttons on it.

2) Computer works on the principle of .................., Processing and Output cycle.

3) Small picture on the desktop are called ...................

4) It is used to prepare ...................... reports.

5) Computer is used to send ......................

6) We input data in computer, it processes them and gives ..................

7) A computer is an ................... machine.

8) ................. is the longest key on the keyboard.

9) ................ program is used to make colourful drawings.

10) To erase a drawing, select .................. tool from tools group.

II. Write 'T' for True and 'F' for False. [10 × 1 = 10 M]

1) By default, typed letters are displayed in capital.

2) The first screen of the windows is called desktop.

3) Computer has very short memory.

4) A computer cannot give correct results.

5) We do not save drawing for future use.

1 Computer Studies ★ SA - IIVikram Text Book - 2

✁
✁

Text Book - 2
Vikram
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6) We canot open a saved drawing in computer.

7) The backspace key is used as an eraser.

8) The start button is used to end any program on the computer.

9) Data entered into computer is called output.

10) Dot matrix is a type of printer.

III. Tick ( ✓✓✓✓✓ ) the correct option. [10 × 1 = 10 M]

1) The thin bar at the bottom of the desktop is called ......................

a) Status bar b) Task bar c) Title bar

2) Which of the following shows the files stored on the computer ?

a) Computer b) Recycle bin c) CPU

3) A standard keyboard has ...................... keys.

a) 96 b) 100 c) 104

4) A ................... works very fast.

a) Computer b) Man c) Animal

5) How many Enter keys are there on a keyboard ?

a) 2 b) 4 c) 8

6) Which of these keys are 26 in number ?

a) Alphabet keys b) Number keys c) Special keys

7) .................. makes a computer run when electricity goes off.

a) windows b) UPS c) CPU

8) Which one of the following is not used to store data ?

a) Pen drive b) CD c) Mouse

9) The printed copy on paper is called ........................

a) Soft copy b) Colour copy c) Hard copy

10) A computer helps to withdraw ....................

a) Ticket b) Books c) Money

2 Computer Studies ★ SA - IIVikram Text Book - 2
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IV. Match the following. [5 × 1 = 5 M]

1) Title bar a) Collection of related command

2) Tab b) Tabs and groups

3) Ribbon c) Contains tools arranged in different groups

4) Group d) Blank area

5) Drawing area e) Displays the currently opened file name

V. Answer the following questions. [5 × 3 = 15 M]

1) Mention the steps to start a computer.

2) What are the uses of computer in a bank ?

3) Which part of the paint window contains tool arranged in different groups ?

4) Which keys help us to move cursor on the screen ?

5) Mention the three steps on which a computer works.

❖ ❖ ❖ ❖ ❖

3 Computer Studies ★ SA - IIVikram Text Book - 2

✁
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4 Computer Studies ★ SA - IIVikram Text Book - 2
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Name : Section : Roll No.

50

SUMMATIVE ASSESSMENT - III
Class - 2 :: Vikram Computer Studies

Time : 2½ Hours Max.Marks: 50

C - 19

Syllabus :
Text Book : (1 to 8 Lessons)
Page Nos : 5 - 68

I. Fill in the blanks with the words given in the box. [10 × 1 = 10 M]

Meteors Ctrl+N Paint 999 Icon

Device Spacebar Mouse Items Power

1) The shortcut key for opening a New document is .....................

2) .................... is the longest key on the keyboard.

3) UPS stands for uninterrupted ..................... supply.

4) It is used in shops to keep details of ...................

5) The default maximum value is ........................

6) In tux math aliens are replaced by ......................

7) ..................... program is used to make colourful drawings.

8) Small picture on the desktop are called ...................

9) Calculator is also an electronic.

10) A .................. has two or three buttons on it.

II. Write 'T' for True and 'F' for False. [10 × 1 = 10 M]

1) Computer has very short memory.

2) The backspace key is used as an eraser.

3) We cannot open a saved drawing in computer.

4) The range of copies .......... repeated .......... wrongs is from 1 to 100.

5) A computer cannot give correct results.

1 Computer Studies ★ SA - IIIVikram Text Book - 2

Text Book - 2
Vikram

✁
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6) A CD can store a little information.

7) We do not save drawing for future use.

8) You have to open the file tab for saving the document

9) TuxMath is a type of space invaders.

10) Icons are small picture of program shown on the desktop.

III. Tick ( ✓✓✓✓✓ ) the correct option. [10 × 1 = 10 M]

1) Rectangle tool is present in .................. group.

a) tools b) image c) shapes

2) ....................... makes a computer run when electricity goes off.

a) Windows b) UPS c) CPU

3) A ................ helps in playing games and drawing pictures.

a) UPS b) CPU c) Mouse

4) A ..................... computer is kept on desk.

a) Laptop b) Palmtop c) Desktop

5) By destroying which meteorities we gain bonus ?

a) Red b) Blue c) Green

6) Which of the following tab is used to open a new file ?

a) Home b) Insert c) File

7) .................... is the set of related commands.

a) Tab b) Ribbon c) Group

8) Which of the following shows the files stored on the computer ?

a) Computer b) Recycle bin c) CPU

9) A standard keyboard has ................... key.

a) 96 b) 100 c) 104

10) A .................. works very fast.

a) Computer b) Man c) Animal

2 Computer Studies ★ SA - IIIVikram Text Book - 2
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IV. Match the following. [5 × 1 = 5 M]

1) Title bar a) Collection of related command

2) Tab b) Tabs and groups

3) Ribbon c) contains tools arranged in different groups

4) Group d) Blank area

5) Drawing area e) Displays the currently opened file name

V. Answer the following questions. [5 × 3 = 15 M]

1) Name the various types of keys on the keyboard.

2) Name the three types of computer.

3) What is Fraction ....... to ....... keep ?

4) Name the area that is used to draw and colour a picture.

5) Write any two differences between computer and calculator.

❖ ❖ ❖ ❖ ❖

3 Computer Studies ★ SA - IIIVikram Text Book - 2

✁
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4 Computer Studies ★ SA - IIIVikram Text Book - 2
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